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Supplementary Information
MMM: A toolbox for integrative structure

modelling
Gunnar Jeschke&

Abstract—This Supplementary Information provides protocols
for reproducing the application examples in the main text. In
MMM version 2017.2, functionality that depends on third-party
programs is only accessible when you run Matlab on a Windows
system.

I. LOCALIZATION BY MULTILATERATION

A. Prerequisites

You need internet access for downloading the PDB file.

B. Localization

In the Matlab command window, change to the MMM
subdirectory demo\T4L_131 and start MMM. In the File
menu use the New from PDB/web item to load the
T4 Lysozyme structure 2LZM. Visualization will be more
pleasing if you now type color [2LZM] lightgrey
in the command line. In the Display menu, use
the Localization item for loading the restraint file
T4L_localization_131_all.dat. The result should
look as in Fig. 1.

Fig. 1. Localization of an MTS label at residue 131 of T4 Lysozyme by eight
distance distribution restraints. Experimental data from Ref.[1] and courtesy
Christian Altenbach.

If you want to change color of the red semitransparent
probability density isosurface, first click on it. The Message
board will display its identifier (131R1), which was spec-
ified in the restraint file, as well as the coordinates of its
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center of gravity and of the point of highest probability.
The latter point is visualized by the small grey sphere in-
side the semitransparent surface. If you now type color
$density:131R1 darkgreen in the command line, the
probability density isosurface will change its color.

C. Rotamer library modelling of the site

In the command line, type select 131 and use the
EPR menu Site scan/selected residues item for
in silico spin labelling. A window Site scan setup
pops up, where you can just click the OK button. Now a
window Set labeling conditions for selected
residues pops up and, again, you can just click OK. Finally,
a file save dialog pops up, where you can just click the Save
button. After a short computation, a dialog window asks you
whether you want to look a the result in a web browser. This
is recommended, click Yes. A browser window opens and in-
forms you that 114 rotamers could be attached with a partition
function of 1.22533. This indicates a very well accessible site
for spin labelling.[2] Go back to the MMM main window
and in the EPR menu, use the Attach precomputed
rotamers item to actually modify the protein model with the
computed label. The Set labeling conditions for
selected residues window pops up again (you could
have computed rotamers of different labels for this site) and
you click OK. Now unselect residue 131 by clicking on the
Unselect toolbutton (this is the red cross toolbutton at the
rightmost position in the toolbutton row). Finally visualize the
spin centers for all rotamers by typing show 131 label in
the Command line.

If you wish, you can search for a better viewing direction
in the rotate mode. This mode is accessed by clicking on the
Rotate toolbutton (the second one in the View control
section of the toolbutton row). The result might look as shown
in Fig. 2. If you wish to save the visualization in a common
graphics format, you can do so either by using the File
menu Export visualization item or by clicking on
the Camera toolbutton in the Graphics section of the
toolbutton row. The Camera toolbutton is available only after
detaching the graphics panel with the leftmost toolbutton in the
3D panels mode section of the toolbutton row. Clicking
on the Camera copies a bitmap into the clipboard (Windows
systems). Please close MMM after you are finished. It is not
required, but good practice, to work with a fresh instance of
MMM when you start a new task. If you have worked on one
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Fig. 2. Comparison of the rotamer prediction of the MTS label distribution
at residue 131 of T4 Lysozyme with its experimental localization.

project with large files and for a long time, it may even be
advisable to close and restart Matlab.

II. LOCALIZATION BY DISTANCE GEOMETRY

A. Prerequisites

You need internet access for downloading the PDB file.

B. Localization of a spin-labelled lipid in soybean seed lipoxy-
genase

In the Matlab command window, change to the MMM
subdirectory demo\lipoxygenase and start MMM. In the
File menu use the New from PDB/web item to load
the PDB structure 1YGE. You might want to type color
[1YGE] lightgrey in the command line. In the Display
menu, use the Network (DMG) item for loading the restraint
file network_Gaffney_explicit.dat.[3] By rotating
the model as described above, you can find the view as in Fig.
1B of the main text. In order to make the site polyhedron better
visible, you can type transparency [1YGE] 0.25 in
the Command line.

III. RESTRAINT-AUGMENTED HOMOLOGY MODELLING

A. Prerequistes

MODELLER [4] needs to be installed on your computer in
a directory where you have write access (download at https:
//salilab.org/modeller/download installation.html). The MOD-
ELLER directory and its subdirectories need to be included in
the Matlab path. Copy all .lib files from the MMM subdirec-
tory \third_party\Modeller_stuff to the \modlib
subdirectory of your MODELLER directory. The program also
needs to be registered with MMM preferences, as the name
of the executable depends on the version number. For version
9.17 that we assume here, it is mod9.17. In the MMM File
menu, select item Preferences and type the Modeller call
for your version in the respective line. Click OK, close and
restart MMM. This needs to be done only once after installing
a new version of MODELLER.

If you want to remove the spin labels after modelling and
you want to repack side chains, you also need SCWRL4[5],
which you can obtain from http://dunbrack.fccc.edu/scwrl4/.
The SCWRL4 directory needs to be on your Matlab path.

Fig. 3. Restraint matching for the Na+/proline symporter PutP by the
moderately homologous template structure of the Na+/glucose symporter
vSGLT. Experimental data taken from Ref. [6]

B. Modelling the eL4 loop of PutP

In the Matlab command window, change to the MMM
subdirectory demo\PutP_eL4 and start MMM. In the
File menu use the New from PDB/local item to
load the PDB file 2XQ2AG that is stored in this subdi-
rectory. The file has been prepared from PDB structure
2XQ2 by only keeping residues 9-500 of chain A. In the
Build menu, for item Fit from template select the
via Modeller subitem. A window Model transition
from template structure [2XQ2] pops up. Use the
Alignment pushbutton of this window to load the alignment
file Olkhova.ali. The message line of this window informs
you that sequence identity of the alignment is in the twilight
zone and the Message board of the main window informs you
that the target sequence of PutP has only 19.1% identity with
the sequence of the template.

Use the Restraints toolbutton of the MOD-
ELLER interface window to load the restraint file
PutP_eL4_Modeller_restraints.dat. The plots
show that some of the distance distribution restraints are
already nicely matched by the template structure, but two
of them are not (Figure 3). A Report editor window
pops up that provides quantitative information on restraint
matching. If you want to keep the initial restraint matching
information, you might want to save this file to a directory
of your choice. By default it is stored in the MMM \tmp
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directory, which is cleared every 30 days. The Report editor
window can be closed by clicking on the OK button.

If you have SCWRL4 installed, you might now want
to activate the repacking checkbox in the Modeller
control panel. By default, MMM will instruct Modeller
to generate 20 models and will import up to 10 models
with the highest DOPE score, but only models that have a
GA341 score of at least 0.75, according to recommendations
for MODELLER.[4]. If you need to change these values to
obtain a sufficient number of models for your application,
it is advisable to not compromise on the GA341 score, but
rather to increase the number of initial models generated by
MODELLER. Click the Run pushbutton. The Message board
of the main window will display messages on start and, after
some time, completion of the MODELLER run.

After completion of the MODELLER run, the Import
button is enabled. After you have clicked it, MMM informs
you how many models were rejected because of a too low
GA341 score and imports the best models. After importing, a
report editor window opens with the information on restraint
matching of the homology models. This information is also
visualized in the MODELLER interface window. In the case at
hand, all restraints are well matched. If SCWRL4 is available
and you had activated the repacking checkbox, MMM now
uses SCWRL4 to repack the sidechains of all models. The
Message board of the main window informs on progress of
this task. After it is complete, you can close the report editor
(OK) and MODELLER interface window.

The models are stored internally in MMM as structures
targ, which is the original MODELLER result with spin-
label side groups still attached, and targr, which is the en-
semble with all native sidegroups and sidegroup repacking by
SCWRL4. In order to save one or both of these ensembles, use
the Display menu Hierarchy item to open the Hierarchy
display window and the Structure dropdown menu in this
window to select the wanted ensemble. You can save it with
the File menu Save PDB as... menu item. After this,
close the Hierarchy display window.

C. Visualization

The template structure 2XQ2 is already displayed as
a ribbon model. Type color [2XQ2] peachpuff in
the Command line to give it a less imposing appearance.
Note that the Command line is available only in Selec-
tion mode. If it is inaccessible, you need to click the
cursor arrow toolbutton in the View control section of
the toolbutton row. To emphasize the residues of vSGLT
that are aligned to the eL4 loop of PutP, type color
[2XQ2]310-348 crimson in the Command line. Now
type show [targr] ribbon. This displays all 10 homol-
ogy models in MMM standard color. The visualization will be
more clear after typing color [targr] lightgrey and
color [targr]{:}294-324 darkgreen. The charac-
ters {:} in the address tell MMM that residues 294-324
should be colored darkgreen for all models in the ensemble.
You can now rotate the model. The result may look slightly
different from the one shown in Figure 2 of the main text, since

homology modelling by MODELLER involves some degree of
randomness.

IV. RIGID-BODY DOCKING

A. Prerequisites

You need internet access for downloading one PDB file.

B. Making a single docking model

In the Matlab command window, change to the MMM
subdirectory demo\integrin and start MMM. In the
File menu use the New from PDB/local item to load
the PDB file 4wtw_A that is stored in this subdirectory.
It contains only chain A of the crystal structure of the
FnIII-3 domain of integrin α6β4. Now use the Add from
PDB/web item to add the PDB file 4wtx as the sec-
ond structure. It contains the crystal structure of the FnIII-
4 domain. The Build menu Docking (rigid-body)
item gives access to the MMMDock module. Using
the Load restraints list button, load the restraint
file integrin_docking_restraints.dat. Select the
Docking method Grid search in the Initialize
docking panel and activate the Automatically fit
from the best grid point checkbox in the Grid
search setup panel. Then click the Run docking push-
button. After a few seconds, docking will be completed. PDB
files with updated coordinates for the two individual domains
are stored automatically.

Fig. 4. Single docking model for the FnIII-3,4 domains of integrin α6β4.

In order to save the docked model to a single PDB file,
type select [trs3,trs4] in the Command line. The
model displayed in the main window should now be high-
lighted yellow, since [trs3] and [trs4] are the MMM structure
addresses of the docked domains. Select the File menu Save
selection as PDB... item and use INTG as a pseudo
PDB identifier (must have 4 characters, but should not start
with a digit). You should obtain the result that is stored as
INTG_docked.pdb in the same subdirectory and displayed
in Fig. 4.
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C. Testing further solutions of the grid search

To inspect more results of the grid search, use the Edit
menu item Reports and load the docking session report
of your previous fit (the file name contains date and time).
Towards the end of the file, you will find the 20 grid points that
gave the lowest RMSD. The model shown in Fig.4 resulted
from local optimization of the first of these points (best-fitting
grid point).

In the MMMDock window, you can now switch to the fit
only mode in the Initialize docking panel. Copy the
second best grid point (Alpha = 135, Beta = 51.43, Gamma =
315, x = 18.75, y = -18.75, z = 0) into the edit fields of the
Fit setup panel and click the Run docking pushbutton.
The solution that you obtain will slightly differ from the one
obtained by automatic local optimization from the best grid
point (compare the result reported in the MMMDock window
to the one in the report file that you still have open in the
Report Editor).

The second solution is stored in MMM structures
[trs5] and [trs6]. You can save it as described above
(INTG_docked_2.pdb) and, if you wish, you can explore
solutions that you get from further grid points. In the following
we assume that a fit was also performed from the third
best grid point. The third solution is then stored in MMM
structures [trs7] and [trs8] and we assume that it was saved in
INTG_docked_3.pdb.

Fig. 5. Three docking models for the FnIII-3,4 domains of integrin α6β4.

D. Generation of an ensemble and visualization

Close all windows except for the MMM main window. With
the File menu New from PDB/local item load the PDB
file INTG_docked and with the Add from PDB/local
item first add INTG_docked_2 and then INTG_docked_3.
The three models will now have MMM addresses [INTG],
[INTG 1], and [INTG 2] (if you have saved all of them with
pseudo-PDB identifier INTG). Now rotate the model to a
convenient view, for instance the one shown in Fig. 5. If you
want to also display a rotation by 90◦, as in Fig. 3 of the

main text, you best define this view as a standard view along
the x axis by using the Build menu item Transform to
viewing frame subitem x along viewing vector.
The superposition will look somewhat better after you type
transparency [INTG,INTG_1,INTG_2] 0.5 in the
Command line (Fig. 5). If you now want to see the model
rotated by 90◦, you can select y in the dropdown menu of the
View panel of the main window. Note that you can also use
the M pushbutton right beside this dropdown menu to store any
current view and can later return to it by selecting memory
in the dropdown menu.

V. CONFORMATIONAL CHANGE BY ELASTIC NETWORK
MODELLING

A. Prerequisites

You need internet access for downloading the PDB file.

B. Modelling the apo form of the HCN ion channel

In the Matlab command window, change to the MMM
subdirectory demo\HCN_change and start MMM. In
the File menu use the New from PDB/local item
to load the PDB file 3etq_A that is stored in this
subdirectory. This file contains only chain A of the
cAMP-bound form of HCN. In the Build menu, item
Fit from template select the by Elastic network
model subitem. A window Fit transition from
template structure [3ETQ] pops up. In this win-
dow, use the Load restraints pushbutton to load re-
straint file Puljung_et_al_PNAS_restraints.dat.
Click the Fit button. Progress in terms of an improvement
of restraint fitting is reported in a separate plot window
that is continuously updated and after completion will look
approximately as in Fig. 6. The results may vary somewhat,
since the algorithm uses random numbers for relative phases of
the normal modes. This feature can be used to generate more
than one model and to get some estimate of the uncertainty.

Fig. 6. Convergence of restraint RMSD during elastic network modeling of
the apo form of the HCN ion channel.

The final model is internally stored in structure [tr2]. After
closing the Fit window, select it by typing select [tr2]
and use the File menu Save selection as PDB...
item and HCNA as a pseudo PDB identifier.
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C. Visualization

Click on the unselect toolbutton (red cross). Hide the
model of the cAMP-bound form by typing hide [3ETQ]
in the Command line. Show the motion model by typing
motion [tr2] [3ETQ]. Color the coil model of the fitted
apo structure by typing color [tr2] goldenrod. The
cones that visualize the motion are a graphics object with
identifier motion:tr2_to_3ETQ. You can change their
color by the command color $motion:tr2_to_3ETQ
darkgreen. By rotating the model, you can obtain the
visualization shown in Fig. 4A of the main text.

To obtain the visualization in Fig. 4B, hide the motion
cones by the command hide $motion:tr2_to_3ETQ.
Type show [3ETQ] coil and then color [3ETQ]
darkgreen to display a coil model of the experimen-
tal cAMP-bound conformation. Now click on the Depth
cueing pushbutton in View panel. You can change the depth
cueing by playing with the front and back plane setting in the
Depth cueing control window, but note that this may
hide parts of the model. Usually the default setting is close
to optimum. Once you close the Depth cueing control
window, display will change back to the normal appearance.

VI. ENSEMBLE MODEL OF A FLEXIBLE PEPTIDE SECTION

A. Prerequisites

You need internet access for downloading the PDB file.
Generation of flexible peptide sections requires SCWRL4 [5],
which you can obtain from http://dunbrack.fccc.edu/scwrl4/.
The SCWRL4 directory needs to be on your Matlab path.
For adding the bilayer model, you need MSMS [7], which
can be downloaded from http://mgl.scripps.edu/people/sanner/
html/msms home.html.

B. Transforming the crystal structure to the symmetry frame

In the Matlab command window, change to the MMM
subdirectory demo\flex_LHCII and start MMM. In the
File menu use the New from PDB/web item to load the
PDB file 2BHW. This is a trimer, but C3 symmetry is not
perfect in this crystal structure. By selecting one residue in
each protomer, you can define symmetry-related sites that
allow for determining the C3 axis to a good approximation.
Type select (A,B,C)60 in the command line and use
the Edit menu Symmetry frame item to transform co-
ordinates to a frame where the C3 axis is the z axis. The
structure will be displayed with the viewing direction along z.

C. Removing residues 10-13 and water from the structure

Click the unselect toolbutton (red cross). Select all
residues in all chains by the select (A,B,C): com-
mand (the : character selects all objects on some hierar-
chy level). Unselect residues 10-13 in all chains by the
unselect (A,B,C)10-13 command. Unselect water by
the unselect (A,B,C)"HOH" command. Using the File
menu Save selection as PDB item, save this edited
structure to a file 2BHW_sym_no_10_13_no_water. You
can still use the PDB identifier 2BHW for this.

In order to work with the edited structure in the following,
you need to reload it using the File menu New from
PDB/local item. Don’t use the Add from PDB/local
item, because this would load the edited structure with MMM
name [2BHW 1] instead of [2BHW] as assumed in the
restraint file.

In the View panel select z from the dropdown menu as
the viewing direction. Type color [2BHW] lightgrey
in the command line.

Fig. 7. Matching of the beacon restraint between residue 3 in the modelled
flexible N-terminal section and residue 34 in the ordered section of the N-
terminal domain of major plant light harvesting complex LHCII. The Gaussian
restraint is shown in red and the simulated distance distribution for all 25
models in the ensemble in black.

D. Modelling residues 3-13 of trimeric LHCII

Select in the Build menu the item Domain
ensemble model to open the window Monte
Carlo ensemble at structure [2BHW]. With
the Restraints toolbutton, load the restraint file
LHCII_Nterminus_restraints.dat. Click the
Run button. Whenever a model is created, it will be
immediately displayed. You will find that the N-terminal loop
is on the backside.

After completion, the Restraint fulfillment by
the ensemble panel of the fit window shows a plot similar
to the one in Fig. 7. Using the > and < button in this panel you
can scan through all distance distribution restraints. After you
are done, you can close the fit window. Change the viewing
direction to -z.

E. Adding a lipid bilayer model

Select in the Build menu the Bilayer item. By using
MSMS, MMM computes the solvent-accessible surface of the
protein. As we know that the C3 symmetry axis is the bilayer
normal and as we already did transform the structure to a
frame where the C3 axis is the z axis, we don’t need to fit
the membrane normal. Since LHCII is a helical bundle, the
default settings in the Build bilayer window can be kept.
Just click on the Fit button and then on OK. This will update
the graphics, which may take a while for the whole ensemble.
Type show [2BHW](A){:}3.CA space-filling,
then color (A){:}3-14 palegreen, and finally
transparency (A){:}3-14 0.5 in the Command line.



PROTEIN SCIENCE, 2017 6

After rotation, the model should look similar to Fig. 5B in
the main text. Details may differ, since ensemble generation
features some randomness.

VII. RIGIFLEX MODELLING

A. Prerequisites

Generation of flexible peptide sections requires
SCWRL4[5], which you can obtain from http:
//dunbrack.fccc.edu/scwrl4/. The SCWRL4 directory
needs to be on your Matlab path. Fitting of the SAXS
curve requires ATSAS [8], which you can obtain from
https://www.embl-hamburg.de/biosaxs/software.html. ATSAS
must be on your Matlab path. The MMM interface is tested
up to ATSAS version 2.8.1. The SAXS curve needs to be
downloaded from https://www.sasbdb.org/data/SASDAT6/
and saved to the subdirectory \integrin by the name
SASDAT6.dat. MMM should be started from this directory.

B. Running Rigi for the FnIII-3,4 domains of integrin α6β4

In the Matlab command window, change to the MMM
subdirectory demo\integrin and start MMM. In the
File menu use the New from PDB/local item to
load the PDB file INTG_rigid_bodies. This PDB
file was constructed from crystal structures 4WTW for
the FnIII-3 domain and 4WTX for the FnIII-4 domain
[9] by making sure that the two rigid bodies are well
separated in space and by removing crystal water. Se-
lect in the Build menu the item RigiFlex to open
the window RigiFlex structure model based on
rigid bodies [INT0]. With the Restraints button,
load the file integrin_rigiflex_restraints.dat.
In the Display mode panel, activate the radio button SAXS
fit. That way the SAXS fits for valid rigid-body arrange-
ments will be displayed during the run of the Rigi module.
Now click the Run Rigi button and provide the file name
INTG.pdb. Rigi should generate the requested 15 models
within a few minutes. After all models are generated, the
module requires some more time to clean them up, save them
to the PDB file, and diagnose restraint fulfillment for the whole
ensemble.

Fig. 8. Matching of the restraints by the rigid-body arrangements of the
FnIII-3,4 domains of integrin α6β4. (A) Restraint between residues 1472 in
the FnIII-3 domain and 1626 in the FnIII-4 domain. Distance distributions
of all models overlap quite well with each other and with the specified
restraint. (B) Potential restraint between reference sites 1472 in the FnIII-3
domain and 1598 in the FnIII-4 domain. This restraint had not been obtained
experimentally and the distance distributions vary more strongly among the
models in the ensemble.

To see how well the restraints are fulfilled, activate the
DEER radiobutton in the Display mode panel. With the <
and > buttons for Core restraints you can navigate to
the desired restraint. If the restraint was specified, you obtain
a plot similar to the one in Fig. 8A. With the < and > buttons
for Model you can display the predicted distance distribution
for any of the rigid-body arrangements.

C. Running Flex for the FnIII-3,4 domains of integrin α6β4

Click on the Run Flex button. For this particular problem,
the Flex module requires long computation times since for
some of the otherwise valid rigid-body arrangements most
of the initially generated loop models clash with the protein.
Therefore, you might want to run the Flex module over night.
The restraint file specifies 15 rigid-body arrangements and a
maximum time of 1 h for generating up to 5 flexible linker
models for each of them, i.e., Flex will run at most for 15 h.
Since for some of the rigid-body arrangements flexible linkers
can be constructed more easily, runtime is shorter in practice.
The RigiFlex window displays progress of the computation.

D. Running Assembler for the FnIII-3,4 domains of integrin
α6β4

Click on the Run Assembler button. For this particular
problem, Assembler spends most of its run time in calls
of the crysol program of the ATSAS package [8] for
fitting the SAXS curve for all valid combinations of rigid-
body arrangements with flexible section models. After the
Assembler run is completed, you may want to open the
file INTG_assembler_report.txt with the report editor
(Edit menu item Reports). The report summarizes how
many models for the flexible section were found for each rigid-
body arrangement and gives the χ2 values for the SAXS curve
fits of all valid combinations. Near the end of the file, the
best-scoring models are sorted by χ2. The requested number
of models in the ensemble (20 in the case at hand) is automat-
ically written to the PDB file INTG_ensemble.pdb. You
can now close the RigiFlex and Report editor windows.

E. Visualization

Using the File menu item New from PDB/local,
load the ensemble INTG_ensemble.pdb. All models are
superimposed on the FnIII-3 domain, as it was specified in the
restraint file integrin_rigiflex_restraints.dat.
In the Command line, type color {:}1454-1548
darkgreen to color this domain for all 20 models, then
color {:}1549-1571 crimson to color the flexible
section, and then color {:}1572-1666 grey to color
the FnIII-4 domain. Rotate the structure to a suitable view,
for instance, the one in the left panel of Fig. 6 of the
main text, and use the Build menu item Transform
to viewing frame with subitem viewing vector
along x to transform coordinates to this frame. The com-
mand transparency {:}1549-1666 0.25 improves
visualization of the sections with distributed relative confor-
mation. By selecting y in the View control panel of the
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main window of MMM, you obtain a view similar to the one
in the right panel of Fig. 6 of the main text. If you wish, you
can save the ensemble with coordinates in this viewing frame
using the File menu Save PDB as... item.

In order to visualize a distance restraint, you can use the
plot command. For instance, plot 1463.CA 1608.CA
3 darkblue draws a darkblue line with width 3 between
the Cα atoms of residues 1463 in the FnIII-3 domain and 1608
in the FnIII-4 domain, corresponding to the first restraint. You
could now repeat this for all restraints, but it is more conve-
nient to use MMM scripting for this visualization. A script
file plot_restraints.mmm is contained in the MMM
subdirectory demo\integrin. After clicking on the Run
script from file toolbutton, which you find above the
right corner of the command line, you need to navigate to
this directory. When you load the script file, all restraints are
displayed as in Figure 6 of the main text.
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